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Overview 
rheaDER is a PDA ebook reader for Palm OS PDAs. Easy-to-use and supporting 
multiple ebook databases it is an extremely handy tool while on the go. rheaDER 
enables you to add notes and bookmarks to the ebooks you read. The possibilities to 
look up word definitions in dictionaries, follow Bible references or view images 
included in ebooks additionally enhance your reading experience. 

Version 3.00 is the automated Reading mode offering Manual, Auto Scroll and 
the Screen Wrap features for reading the text. The Reading mode will allow you 
to relax and read ebooks while holding your PDA with one hand, placing it on a 
surface or on the cradle. rheaDER allows you to define a set of reading preferences 
(font size appropriate for reading longer passages, etc.) so, next time you decide to 
read an ebook you will already have your reading preferences saved and will fully 
concentrate on the reading. Using the Ribbon feature, a special mark indicating the 
last paragraph read, facilitates you even more in your reading. 

Version 3.19 supports GMPSoft’s bilingual dictionaries. 

 

How to get rheaDER 
The PDA rheaDER program is free and goes with each ebook download on 
GMPSoft‘s websites:  
 
Order eBooks from: http://ebooks.gmpsoft.com, http://ebooks.reftogo.com and 
http://www.rheader.com 
 
For more information about GMPSoft products and services, visit us at: 
http://www.gmpsoft.com. 

 

 

 

 
Warning: Some of the screenshots herein have been taken from Archaeology: A 
Very Short Introduction (©Paul Bahn), The Bible: A Very Short Introduction (©John 
Riches), The Pocket Oxford English Dictionary, The Concise Oxford English Dictionary 
and A Dictionary of the Bible (All © Oxford University Press). 



 

1 Starting the Application 
 
Locate the rheaDER icon on the Applications screen of your Palm OS handheld.  
Launch the application by tapping on the icon.  
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 



 

2 Registration 

2.1 Licenses 

The GMPSoft licenses for using ebooks with rheaDER program are as follows: 
 

1. Standard License – The ebook comes with one 
or two unlocked chapters as a demo. The rest of 
the chapters are locked until you order the license 
and install your registration database file, 
PADUnlock. 

 
Note: Locked chapters are denoted by red color in the list 

of Contents and the free chapters are denoted by green 
color.  

 
2. Free License – The ebook is free to install and read. 

 

2.2 Product Registration  

This product can be registered with the help of a small database file, PADUnlock 

(PAlm Database Unlock System). You receive your PADUnlock file after you order 
a License for a GMPSoft product and register it in our system database. PADUnlock 
contains the registration information about all products you have ordered from one 
email address and is in .pdb file format - ready to be installed on your PDA.  
 

1. Get your PADUnlock: 
� Follow the Unlock Key link in the GMPSoft Sales 

Confirmation email you have received after the 

purchase. 

� Click on GET IT link in your Product Info page.  
� Save the file on your PC 

 
2. Install PADUnlock 

� Hotsync the PADUnlock database to your device’s 

RAM or on the expansion card. 
 

3. Go to the Registration form: 
� Launch a GMPSoft product 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on Book 

� Tap on Registration 

Or 
� Draw the Graffiti Menu Command stroke   and the letter 

R on the silkscreen 
Or 

 

 



 

 

� Tap on the Register button in the trial reminder 
form  

 

4. Apply your PADUnlock registration information: 
� Tap on the Scan button  

 
GMPSoft products support PADUnlock Key protocol and use it 

to automatically register your products. 

 
Note: The Trial reminder form will still appear if there is even 

one product with a Trial License state. 



 

3 Using rheaDER 
The rheaDER program allows you to read ebooks taking advantage of the specifics 
the modern PDA devices provide. The out-of-date paging concept from the times 
when PDA technology didn't allow text resizing is fully abandoned. Instead, ebooks 
are divided into logical units. This makes for easy intuitive navigation in the text 
either with the buttons of your device, or the screen scroller. rheaDER allows 
instant access to the Contents of the active book, addition of personal notes and 
bookmarks to the text, opening of pop-ups with footnotes and even cross references 
to the Bible if available for the particular ebook. rheaDER supports images and 
illustrations that may be accessed directly from the text. The possibility for word 
lookup in a set of dictionaries in DEPReader makes rheaDER suitable even for in-
depth study. 
 

3.1 Select A Book To Read 

rheaDER allows users to have multiple ebooks installed and switch between them.  

1. Open the Select Book form 
� Tap on the Headline bar or the Menu button to display 

the Book menu 

� Tap on Book... 
Or 

� Draw the Graffiti Menu Command stroke   and the letter 
L on the silkscreen 

 

 
 

 

2. Scan for new ebooks  
� Tap on the Scan button 

 
rheaDER stores cached information about the available 

databases. This speeds the operation when you use memory 
cards.  

 

It is not necessary to scan each time. Scan when you: 
• Install new ebook(s) 

• Delete ebook(s) 

• Transfer ebook(s) from handheld RAM to the memory 

card or vice versa 

• Move ebook(s) in another folder of the memory card 

 
 

3. Choose an ebook  
� Tap on the desired ebook in the list 

  
4. Confirm 

� Tap on the Done button 

 

 



 

3.2 Select Additional Resources 

rheaDER supports other resources such as GMPSoft dictionaries and Bibles that may 
be used as additional reference while reading ebooks. Word definitions and Bible 
quotations are displayed with a single tap in pop-up windows without interrupting 
your reading process. Even more, with multiple dictionaries installed rheaDER will 
allow you to view multiple definitions provided by each one of them. 

 

Download compatible Dictionaries from: www.reftogo.com,  
www.depreader.com 

 

Download compatible Bibles from: www.biblewithyou.com 

 

1. Open the Select References form 
� Tap on the Headline bar or the Menu button to display 

the Book menu 

� Tap on Dictionary... or Bible… 
Or 

� Draw the Graffiti Menu Command stroke   and the letter 
D or B on the silkscreen 

 

 
 

 
 

2. Scan for new Dictionaries and Bibles 
� Tap on the Scan button 
 

RheaDER stores cached information about the available 
databases. This speeds the operation when you use memory 

cards.  

 
It is not necessary to scan each time. Scan when you: 

• Install new resource(s) 

• Delete resource(s) 

• Transfer resource(s) from handheld RAM to the 

memory card or vice versa 
• Move resource(s) in another folder of the memory 

card 

 

3. Choose one or more Dictionaries  
� Enable the Dictionaries checkbox  

� Enable the checkboxes before one or more of the 
installed dictionaries 

  
4. Choose a Bible  

� Tap on a Bible translation in the list 

 
5. Confirm 

� Tap on the Done button 

 

 



 

3.3 Adjusting the Preferences 

rheaDER allows personalizing its layout by selecting a different font size or applying 
bold formatting that will help you see better the text. As ebooks are divided into 
logical units rather than into pages, no re-paging will occur. 
 

1. Choose Preferences from the Edit menu 
� Tap on the Headline bar or use the Menu button to 

display the form menu 
� Tap on the Edit menu 

� Tap on Preferences 

Or 
� Draw the Graffiti Menu Command stroke   and the letter 

P on the silkscreen 

 
  
2. Text size – you can choose Smaller size to have 

more text displayed at a time or Larger  
� Tap on the down arrow next to Text size to expand the 

drop-down list  
� Choose a text size from the drop down list options 

 

3. Apply bold formatting to text – enabling of this 
option is recommended for people with poor 
eyesight or in case the light is not sufficient 
� Enable the Apply Bold Formatting option  
 

Warning: Enabling bold formatting may remove the 
distinction between some sections (e.g. subsection headings.) 

 

4. Apply colors – disabling this option will turn off the colors used in the Book 
texts. 
� Disable the Apply colors option  
 

5. Confirm 
� Tap on the OK button 

 

 

 
 

 
 

 
 

 

 



 

 

3.4 Viewing the Contents of a Book 

rheaDER allows viewing book contents and easily accessing the chapters and  
subchapters of each ebook. 
 

1. Open the Contents form  
� Tap on the Headline bar or use the Menu button to 

display the form menu 
� Tap on the View menu 

� Tap on Contents 
Or 

� Draw the Graffiti Menu Command stroke   and the 

letter C on the silkscreen 

 
 
 

Or 

� Tap on the Contents icon (  ) in the Headline 
bar 

 
 
  
 
 
 
 
2. Select a chapter  

� Use the scroller bar to scroll the list of contents up 

and down 
� Tap on a chapter in the list of contents 

 

The selected chapter will be highlighted and will be displayed 
in the footer of the screen.  

 
Some Books may have their chapters divided in subchapters 

or paragraphs. In such cases, you’ll see in the footer the 

indication of a subchapter (I, 1, a subtitle, etc.) 
 

The grey icon ( ) indicates that an item from the list is a 

chapter and the blue icon ( ) indicates that it is a 
subchapter. 

 
 

 
 

 

 

 

 

 



 

 

3. Select a subchapter or a paragraph  
� Tap again on the same chapter in the list of Contents 

(The Making of… from the previous screenshot) 
 

 
 
 

 
 

 

 
 

4. Go back to the full list of Contents  

� Tap on the    icon in the Headline bar 

Or 
� Tap on the title of the parent chapter in the screen 

footer (Part I. in this example) 
 

 

 
 

 
 

 

5. Open the selected chapter, subchapter or 
paragraph 

� Tap on the   icon in the Headline bar  

  
 

 

 
 

 
 

 
 

6. Go back to the last paragraph that you were 
reading 

� Tap on the   icon in the Headline bar  

 

 
 

 
 

 
 

 

 
 

 

 

 

 



 

 
 

3.5 Reading Ebooks 

 
1. Read a section  
 

� Use the scroll bar or you to move the text up and 

down within a section.  
 

� Use your device's scroll button to move the text up 
and down within or between sections. 

Or 
� Move the Sony Jog Dial wheel up/down to move 

the text per one line. 

 
 

2. Scroll the text up and down by pages 
� Use Page Up/Page Down buttons, the 5way 

navigation button of your handheld  

Or  
� Push the Sony Jog Dial wheel and move it 

up/down. 
 

3. Move between chapters 
� Use Page Up/Page Down buttons or the 5way 

navigation button of your handheld  

Or  
� Push the Sony Jog Dial wheel and move it 

up/down. 

 

3.6 Viewing Illustrations 

rheaDER application allows viewing the illustrations available in some ebooks. 
 

Illustrations and pictures are denoted in their proper place in 

the text with a brief description as blue and underlined links.  

 
1. Display an illustration 

� Tap on the link in the text marking an illustration 

 
 

 

 
 
 
 
 

 

 

 



 

 
Note: This illustration represents Giotto’s Cappella Scrovegni, 
photo: Archivi Aliani. The screenshot has been taken from 

The Bible, A Very Short Introduction. 
 

 
Orientation: In order to view some of the images properly, 

you need to rotate your device. The images’ orientation is 

indicated by the Portrait or Landscape icon in the Headline 
bar before the Image’s Title. 

 

  Portrait view: The image is orientated properly on the 
screen.  

 

 - Landscape view: The icon suggests that you need 

to rotate your Palm device in order to view the image 
properly. 

 
 

2. View the next or previous image in the same 
chapter 
 

� Tap on the Forward or Backward arrow in the Headline 

bar to move to the next or previous image in the same 
chapter 

 
 

 
 

 

 

3.7 Viewing Dictionary Definitions 

 
1. Open a pop-up with a word definition 

� Tap on a word in the text and hold the stylus until the 

pop-up window is displayed 

 
Notes:  

 
1. You need to hold the stylus a little longer than just tap on 

the screen with it (~ 1/3 sec.) 

 
2. If the word is found in only one of the active dictionary 

databases, a pop-up will show directly the definition. 
 

3. If the word is found in more than one of the dictionaries, 
and (or) there are several meanings, the definition pop-up 

will show a list of the different meanings found in each of 

the active dictionaries.  

 

 

 



 

2. View a particular meaning of a word 
� Tap on it in the list of word’s meanings in the pop-up 

window 

 
3. Navigate within the pop-up if needed 

� Tap on the scroll bar within the pop-up with the stylus 

 
 

4. Return to the list of different meanings of the word 
� Tap on the << sign before the dictionary name 

 
 

5. View a Bible reference found in the definition 
References to Bible verses are indicated by the abbreviation 

of the Bible book and the numbers of chapter and verse, in 
blue color, underlined. 

 

� Tap on the reference in the definition pop-up 

 
 

The respective verse(s) from the Bible reference will be 

displayed on the screen.  
 

 

 
 

 
 

 
 

 

 
 

 
 

6. View a reference to a word  
Word definitions may include  references to other words in 
the same dictionary. This is indicated by blue color, 

underlined. 
 

� Tap on a blue, underlined word in the definition 

 
The definition of the referenced word will be displayed in a 

new pop-up 
 

 
7. Return to the ebook text 

� Tap on a blank space within the definition pop-up 

Or 

� Tap on the screen outside the definition pop-up 
 

 

 

 

 

 



 

3.8 Displaying Footnotes  

 
rheaDER allows you to view the footnotes available in the text of some ebooks. 
 

The footnotes are indicated by a number in square brackets 
and are displayed for more convenience as tool-tips and not 

below the text. 

 
1. View a footnote 

� Tap on the footnote number in square brackets in 

superscript 

 
2. Close a footnote pop-up 

� Tap inside the footnote pop-up or anywhere on the 
screen  

 

3.9  Displaying Bible References 
 

The references to the Bible available in some of the ebooks are indicated by a blue 
and underlined font. If you have installed a GMPSoft Bible, you can visualize the 
reference by displaying the verses in a pop-up from the text of your ebook. 
 

Get Bible translations from: http://www.biblewithyou.com 

 

1. Display a cross reference 
� Tap on a cross reference in the text 

 
 

2. Close pop-up with cross references 
� Tap on a blank space inside the cross reference pop-up 

 

3.10 Working With Tables 

rheaDER allows you to view the tables included in some ebooks. Tables are opened 
in new screen Tables may contain one or more columns with entries on a certain 
topic. The names of the tables are indicated by capital letters.  
 

1. Choose Tables… from the View menu 
� See how in section…. 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 

� Tap on Tables… 
Or 

� Draw the Graffiti Menu Command stroke   and the letter 

T on the silkscreen 

 

 

 



 

 
 

 

2. View Next or Previous Tables 
� Tap on the forward or on the backward arrows in the 

Headline bar  
 

Some ebooks may contain more than one table. 

 
 

 
 

 

 
 

3. Open a table from the text: 
 

Tables are denoted by blue and underlined hyperlinks in the 

text. To open a table while reading an ebook:  
 

� Tap on the hyperlink indicating a table in the text 
(table 1 in this example.) 

 

 
 

 
 

 

4. Return to the ebook text 

Tap on the rheaDER icon ( ) at the right upper corner of 

the screen 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

 

 



 

 

3.11 Reading History  

 
rheaDER keeps a history list of the passages you have visited allowing you to move 
back and forward in it. 
 

1. Go to the previous passage in the history list 
� Tap on the Headline bar or the Menu button to 

display the form menu 

� Tap on View 

� Tap on Previous 
Or 

� Draw the Backspace Graffiti Stroke on the silk screen 
Or 

� Select Backspace button in the Virtual or the 
Hardware Keyboard 

Or 

� Draw the Graffiti Menu Command stroke to display the 
command bar 

� Tap on the Back  arrow 
Or 

� Tap on the Back Arrow icon in the Command Toolbar if it 
is shown 

 

 

2. Go to the next passage in the history list 
� Tap on the Headline bar or the Menu button to 

display the form menu 
� Tap on View 

� Tap on Next 
Or 

� Draw the Space Graffiti Stroke on the silk screen 
Or 
� Select Space button in the Virtual or the Hardware 

Keyboard 
Or 

� Draw the Graffiti Menu Command stroke to display the 
command bar 

� Tap on the Forward arrow 

 
Or 

� Tap on the Forward  Arrow icon in the Command Toolbar 
if it is shown 

 
 

 

 

 

 



 

3.12  User Notes 

 
rheaDER allows you to attach your personal notes to a whole chapter or to each 
individual paragraph from the ebook you are reading. 
 
Only one Note may exist for a particular section. 

3.12.1 Attaching Notes 

 
1. Attach a Note 

� Tap on the Notes icon  in the Headline bar 
Or 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 

� Tap on Edit Note 
Or 

� Draw the Graffiti Menu Command stroke   and the 

letter I on the silkscreen 
 

2. Enter your text 
� Use the Graffiti writing area or the System Keyboard 
 

3. Change the Note category 
� Tap on a Notes category displayed at the right top corner 

of the screen 

Or 
� Click on the Details button 

� Select a category from the Category list 
� Tap on OK 

 

3.12.2 Edit a Note 
You may edit a note, if one exists for a particular chapter or 

paragraph - Same as 3.12.1.  
 

Note that the icons for Adding a Note ( ) and for Viewing 

an Existing Note ( ) are slightly different. 

 
 
 
 
 
 

 

 



 

3.13 Bookmarks 

 
rheaDER allows you to add bookmarks to the chapters of the ebook you are reading 
or to each individual paragraph in a particular chapter. As they are connected with a 
specific ebook, you will not be able to view them if the active ebook is changed.  

3.13.1 Adding Bookmarks 

 

5. Choose Add to Bookmarks from the View menu: 
� Tap on the Headline bar or the Menu button to display 

the form menu 

� Tap on View 

� Tap on Add to Bookmarks 
 

Or 

� Tap on the Add to Bookmarks icon  in the Headline 

bar 

 
Or 

� Draw the Graffiti Menu Command stroke   and the 

letter O 
 

3.13.2 Managing Bookmarks  

1. Choose Bookmarks from the View menu: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 

� Tap on Bookmarks 

Or 
� Draw the Graffiti Menu Command stroke to display the 

command toolbar 

� Tap on the Bookmarks icon  in the Headline bar 

 

Or 
� Draw the Graffiti Menu Command stroke   and the 

letter K 
 

Note: You need to have at least one bookmark in order to 

open the Bookmarks form.  

 
2. Select a bookmark 

� Tap on it in the list 

 
3. Edit a bookmark 

You can change the name of the bookmark and the category 
it belongs to. 

� Tap on Edit 

 

 

 



 

 

3.1. Rename the bookmark 
By default, the names of Bookmarks include the abbreviation 

of the ebook and the chapter title or the first few words from 
the respective paragraph.  

�  Enter the new name 
 

3.2. Change the category of a bookmark 
You can choose the bookmark’s category from the list of 
current categories or create a new category. 

� Tap on the triangle button against Current category 

� Tap on a category in the drop down list 

 
4. View a bookmark 

� Tap on Go To 
Or  

� Tap on it again 
 

5. Delete a bookmark 
� Tap on Delete  
 

6. Exit to Book text  
� Tap on Back 

 

3.13.3 Managing Bookmark Categories 

1. Create a new category 
� Open the Bookmarks form (see how at 3.13.2) 

� Tap on Edit Categories... from the Category list 
� Tap on New 

� Enter the category name 
� Tap on OK 

 

2. Rename a category 
� Open the Bookmarks form (see how at 3.13.2) 

� Tap on Edit Categories... from the drop down list 
� Tap on Rename 

� Enter the new name 

� Tap on OK 

 
3. Delete a category 

� Open the Bookmarks form (see how at 3.13.2) 
� Tap on Edit Categories... from the drop down list 

� Tap on category 
� Tap on Delete 

 



 

4 Automated Reading Mode 
 
The Reading mode of rheaDER is especially designed to enhance your reading 
experience by choosing either Auto Scroll, Screen Wrap or Manual reading 
modes. The Reading mode will allow you to relax and read ebooks while holding 
your PDA with one hand, placing it on a surface or on the cradle. rheaDER allows 
you to define a set of reading preferences (font size appropriate for reading longer 
passages, etc.) so, next time you decide to read an ebook you will already have your 
reading preferences saved and will fully concentrate on the reading. Using the 
Ribbon feature, a special mark indicating the last paragraph read, facilitates you 
even more in your reading. 
 

4.1 Adjusting the Text Preferences for Reading Mode  

rheaDER allows defining different sets of preferences for reading ebooks. For 
example, you may choose a bigger font size, applied bold formatting etc. for easier 
reading. 
 

1. Open the Text Preferences form 
� Tap on the rheaDER bar or use the Menu button to 

display the form menu 
� Tap on Read 

� Tap on Text Preferences… 
Or 

� Draw the Graffiti Menu Command stroke   and the letter 

F on the silkscreen 
 

 

 
2. Select a Reading mode option – these options 

refer to the navigation. In Manual mode you use 
the Page Down button to scroll down, while in  
Auto Scroll and Screen Wrap modes the text 
moves down automatically, you only adjust the 
speed. 

� Tap on the down arrow on the left of Reading Mode 

field  
� Tap on Manual, Auto Scroll or Screen Wrap 

 

 

3. Text size – Medium or Larger are suitable for reading 
� Tap on the down arrow next to the Text size field  

� Choose a text size from the drop down list 
 

 

 

 



 

4. Apply bold formatting to text – enabling of this option is recommended for the 
Auto Scroll and the Screen Wrap modes 
� Enable Apply Bold Formatting check box  

 

5. View last line 
This feature allows you to vie the last line of the previous 

page when paging down the text. 
 

6. Confirm your preferences 
� Tap on OK 

 

 
 

4.1.1 Auto Scroll Mode 

The text in Auto Scroll mode is being smoothly auto scrolled up. The user may 
adjust the speed of scrolling or pause the auto scroll. 
 

1. Initiate Reading 
� Tap on the Headline bar or the Menu button to display 

the form menu 

� Tap on Read 

� Tap on Start Reading 
Or 

� Draw the Graffiti Menu Command stroke   and the letter 
G on the silkscreen 

Or 

� Tap on the  icon if you have selected a ribbon to 

continue reading (See 4.2 Ribbons) 

 
2. Increase speed  

� Press and hold the Page Down button until you reach 

the desired speed 
Or 

� Roll the Sony Jog Dial wheel Downward 

 

3. Decrease speed  
� Press and hold the Page Up button until you reach the 

desired speed 

Or 

� Roll the Sony Jog Dial wheel downward 
 

4. Pause 
� Press and hold any of the rest Hardware Buttons 

(Launcher, Menus, Calculator, Find ) 

Or 
� Press and hold the Sony Jog Dial wheel  

 

5. Determine the most appropriate speed: 
� Go to a verse you would like to start from  



 

� Start reading (see point.1)  
� if you manage to read the text until under 2-3 lines 

from the centre of the page, press Page Down 

button to accelerate.  
� Repeat, until you keep reading the text in the 

centre.  
� Best speed for you is the one at which you read the 

text close to the centre  

 
Notes: 

 1. If you have lost concentration, just pause Autoscroll.  
 

2. Once you have determined the appropriate for you speed, 
you need only to use the buttons for Pausing, when you 

need to stop for a while.   

 
3. If you change any of the Preferences (for example text 

size), repeat the procedure to obtain the most appropriate 
speed for the new preferences. If necessary, press Page Up 

beforehand to decrease the speed. 

 

6. Exit the Autoscroll mode 
� Press anywhere on the screen - you could do this 

even by tapping on the screen with your thumb. 

                     

4.1.2 Screen Wrap Mode 

 
In the Screen Wrap mode, next page is being smoothly 
rolled down from the top of the screen, while the user is 
reading the current page. The user may adjust the speed 
of updating of the screen or may just pause. 

1. Initiate Reading 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on Read 

� Tap on Start Reading 
Or 

� Draw the Graffiti Menu Command stroke   and the letter 
G on the silkscreen 

Or 

� Tap on the  icon if you have selected a ribbon to 
continue reading (See 4.2 Ribbons) 

 
2. Increase speed  

� Press and hold the Page Down button until you reach 

the desired speed 

Or 
� Roll the Sony Jog Dial wheel downward 

 

3. Decrease speed  



 

� Press and hold the Page Up button until you reach the 
desired speed 

Or 

� Roll the Sony Jog Dial wheel downward 
 

4. Pause 
� Press and hold any of the rest Hardware Buttons 

(Launcher, Menus, Calculator, Find ) 

Or 
� Press and hold the Sony Jog Dial wheel  

 

5. Determine the most appropriate speed: 
� go to a verse you would like to start from  

� Start reading (see point.1)  
� If you are reading too close above the horizontal 

line, accelerate with the Page Down button 
� If you are reading too close under the horizontal 

line, slow down with the Page Up button 

 
 

Notes:  
1. Try to keep reading not too close to the horizontal line.   

2. Disregard the moving of the horizontal line for better 

reading. 
3. If you have lost concentration, just pause Screen 

Wrap.  
 

4. Once you have determined the most appropriate speed, 
you need only to use the buttons for Pausing, when you 

need to stop for a while.   

 
5. If you change any of the Preferences (for example text 

size), repeat the procedure to obtain the most 
appropriate speed for the new preferences. If necessary, 

press Page Up beforehand to decrease the speed. 

 
 

4.1.3 Manual Mode  

In the Manual mode, the user scrolls the text manually one page/line up with the 
help of the hardware buttons or the Sony Jog Dial wheel. 
 

1. Move the text per line  
� Roll the Sony Jog Dial wheel downward 
 

2. Move the text per page 
� Press Page Down hardware button 

Or 

� Roll the Sony Jog Dial wheel Downward 
 

3. Exit the Manual reading mode 



 

� Press anywhere on the screen - you could do this 
even by tapping on the screen with your thumb  

 

4.2 Ribbons 

rheaDER allows you to add user marks, called Ribbons, in Reading mode to save 
the last passage read in a certain chapter of the current ebookBible book. Next time 
you start the reader, you may continue reading from the same place. You can have 
ribbons in different parts of each ebook - for example, in the Preface, Chapter 1, the 
conclusion etc. 
 

4.2.1 Add a Ribbon 

 
� Go to a place in the ebook from which you would like the 

to start your reading. 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on Read 
� Tap on Add Ribbon 

Or 
� Draw the Graffiti Menu Command stroke   and the letter 

E on the silkscreen 

      

4.2.2 Go To a Ribbon 

Opens Bible With You on the last passage read in the 

Book, where you have the Ribbon attached. 

 
1. Open Ribbons form 

� Tap on the Headline bar or the Menu button to 

display the form menu 
� Tap on Read 

� Tap on Ribbons 
Or 

� Draw the Graffiti Menu Command stroke   and the 
letter H on the silkscreen 

 

  Ribbons are named after the name of the current passage – 
for example, Introduction, Preface, etc. 

 
2. Select a Ribbon from the list 

� Tap on one in the list 

 

3. Go to the text  
� Tap on Go To button 

 

4. Start Reading mode 
� See 4.1.1 Initiate Reading  for instructions  

 

 



 

 
 

5. Exit Reading Mode  
� See 4.1.1 Exit the Autoscroll mode for instructions  

 

Note: When you exit the Reading mode, the Ribbon will 
save the information about the last passage you have read. 

 

 

 

4.2.3 Delete a Ribbon 

� Tap on the Delete button in the Ribbons form 

 

4.3 Auto Off Power 

Palm PDAs have very short intervals for auto-powering off.  
To give you more time for continuous reading, rheaDER overrides these settings in 
the Reading mode.  
 
To prevent your battery from draining, a warning 
message will be displayed 20 minutes after you have 
started any of the Reading modes.    
 

1. Continue your reading:  
� Tap on OK button 

 

2. Leave Reading mode  
� Tap on STOP button 

         
If you don’t choose either option within the time interval set for Auto-off in your 
device’s preferences, the Reading mode will be exited and your device will be 
Powered Off.  

 
 

 



 

5 Contact and Support 
 
Technical Support 
In order to report problems or ask questions with regards to the software, contact 
our Technical Support Department: 
E-mail: support@gmpsoft.com 
Online: http://www.gmpsoft.com/faq.php 
 
Sales 
In order to obtain general information or product and sales related information, 
contact our Sales Department: 
E-mail: sales@gmpsoft.com 
Sales points:  
http://ebooks.gmpsoft.com, http://ebooks.reftogo.com, http://www.rheader.com 
 
Partnership and Business Development 
In order to enquire about volume licensing, partnership and B2B, contact our 
Management Department: 
E-mail: ceo@gmpsoft.com 
 
 
For detailed information on GMPSoft products, sales, registration, and technical 
support, check out our website: www.gmpsoft.com  
 
 
 
 
 
 
 

6 Copyright and Usage Information 
This PDA software product and the algorithms used are property of GMPSoft. All 
rights reserved, 2005 - 2007. 
 
 


